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The File Menu
Location: Market Analyser Title Bar

Under the menu heading file you will find two areas of interest.

PARAMETERS FEATURE

GENERAL

Default Exchange
- Allows you to choose which exchange. For example if your default exchange was 

NYSE then if you typed in BHP in the code box it would automatically come up 
with BHP.N. 

Auto Log In

- You can also Tick or Un-tick the Auto Log In Feature. By unticking this feature you 
will need to type your user name and password in each time you log in.
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MENU/BUTTONS

Edit List

- If you have typed a code incorrectly in the Code Box this is where you can delete and 
add  correct  codes.  Click  on  the  Edit  List  and  ADD and  REMOVE unwanted  or 
incorrect codes

          

You can also chose to utilise a Mouse Click to drop a menu down, or a Mouse Over which 
means you will not need to click.
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TABLE SETTINGS

In this feature you change the entire appearance of Market Analyser except the charts which 
can be changed in the Chart  Properties on the chart.  Refer below. You can add different 
schemes by clicking on the ADD button and creating a new look.

Use Default Settings
This is a master control that determines whether the table being looked at follows the master 
Table Settings values, or whether they are independently set for the particular table being 
looked at.

Label Font 
Allows the user to select a font and its size and description, to be used for any labels (not 
values) in the table.

Value Font
Allows the user to select a font and its size and description, to be used for any values (not 
labels) in the table.

Background Colour
The colour of background area in the table.

Column Header Background 
The colour of column headers in the table.

Row Colours|Primary Colour 
The  background  colour  of  every  second  row  in  the  table.  Setting  Primary  Colour  and 
Secondary Colour to different colours stripes the table, making it easier to follow rows of data 
across.  Setting  Primary  Colour  and  Secondary  Colour  to  the  same  colour  removes  the 
striping. (examples are further below)

Row Colours|Secondary Colour 
The background colour of every alternate second row in the table. Setting Primary Colour and 
Secondary Colour to different colours stripes the table, making it easier to follow rows of data 
across.  Setting  Primary  Colour  and  Secondary  Colour  to  the  same  colour  removes  the 
striping.
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Autosize Columns 
If selected, this function sets column widths according to the width of the data in the columns. 
It makes a best fit guess.

Draw Selection
Sets whether or not an area of the table selected with the mouse remains highlighted. If Draw 
Selection is un-ticked, the highlighted area will simply receive a dotted outline.

Blush 
Sets whether or not a value in the table that has gone up will  get  (for a few seconds) a 
different background colour: that colour set in Increase. Similarly, Blush sets whether or not a 
value in the table that has gone down will get (for a few seconds) a different background 
colour: that colour set in Decrease.

Increase
Sets the colour which indicates that a value has increased. See Blush above.

Decrease
Sets the colour which indicates that a value has decreased. See Blush above.

Positive Colour 
Certain selected columns display values with different colours depending on whether they are 
positive or negative values. Sets the colour assigned to positive values for these columns.
Negative Colour
Certain selected columns display values with different colours depending on whether they are 
positive or negative values. Sets the colour assigned to negative values for these columns.
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CHART

This is the area where you can set Market Analyser to do such things as:

Show Last Price on Axis
- A handy tool that will show you the last price on the right hand Axis on your Charts. It 

is recommended you leave this ticked

Scripts on Visible Points Only
- If using scripted indicators this option can be utilised to make loading faster by only 

calculating values that are visible on the screen. For example if you are only looking at 
six months of data on your screen the scripts will only be visible. If you zoom your 
chart in to view 3 years data you will need to refresh you chart by hitting enter to view 
further scripts

Draw Multiple Trend lines
- Another handy tool which allows you to draw multiple trend lines without having to 

continually click on the Trend Line Icon. Right mouse clicking will turn the feature 
off on the charts

Wrap Tool Bar
- Allows the tool bar to wrap around so you can view each icon which is particularly 

handy if you tile your windows.

Confirm Remove All Indicators
- A recommended item to keep ticked.  If you accidentally right mouse click on a chart 

and click remove all indicators this feature will prompt you to confirm if you wish to 
do this or not.
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ORDER MANAGEMENT

If you have set up an account with one of our brokers to trade online via the Market Analyser 
this is where you set the program which will provide you access to the BUY/SELL feature on 
the Market Analyser Title Bar
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The File Menu
Location: Market Analyser Title Bar

Under the menu heading file you will find two areas of interest.

CUSTOMISE QUICK LAUNCH FEATURE

In this feature by clicking on the icon in the Available Commands list and clicking the arrow 
> you can add your favourite icons to your main Market Analyser Title Bar. You can remove 
items by clicking on the Tool Bar Icons and using the arrow < to remove them.

The Automatic Button Management 
- By ticking this feature the most used icons will be placed first on your title bar tool bar

Reset Usage
- Resets the usage back to a zero value
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The Windows Menu

Always On Top 
- Allows the application bar to always stay on top of all other windows, both within the 

program and outside it. 

Auto Dock On Maximise 
- Sets  the  application  bar  to  automatically  dock to  the  top  of  the  screen  when  the 

maximise button (the middle button of the three small buttons at the upper right of any 
window) is clicked. 

Auto Hide 
- Sets the application bar to automatically slide out of view when the mouse is not over 

it. If the application bar is docked at the top of the screen, you can find it again by 
moving the mouse to a position at the top of the screen, and the application bar will 
slide down into view. If the application bar is docked at the bottom of the screen, you 
can find it again by moving the mouse to a position at the bottom of the screen, and 
the application bar will slide up into view. 

Docking 
- Forces the application bar to be attached to the top of the screen, or to the bottom of 

the screen, or to simply float anywhere on the screen as other windows do. These 
options are called "Dock to Top"; Float" and "Dock to Bottom". 

Lock Toolbar 
- This prevents accidental re-design of the contents of the application bar, by locking 

objects on it so they cannot be dragged. 

The above example shows that  the  open windows are  hidden.   You will  need to  do  the 
following to rectify this:

- Click Windows 
- Take the tick OFF Lock Tool Bar
- Move your mouse to the far right hand side until a double sided arrow appears
- Click hold and drag the windows back into position
- Click Windows
- Place a tick ON Lock Tool Bar

Close All
- This feature will close all open windows which saves closing them individually
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Tile
- You can tile your windows. If you wish to utilise this feature, ensure that you have the 

required windows open and then click on Tile. If you have 10 windows open, then 10 
windows will tile.

-

Tile Vertically
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Resize Windows

- You can resize each window manually by placing your mouse in the corner or side of 
each window and clicking and dragging.

 Maximise the window by using the middle MAXIMISE button on the window

Restore the window back into its position within the tiles by using the middle RESTORE 
button on the window

Title Bar

Page- 14 -



 Market Analyser Helpful Tips Guide

The Help Menu
Location: Market Analyser

WALKTHROUGHS

In this area you will find over 20 different videos of each feature of the program ranging in 
duration from 3 to 15 minutes

ONLINE MANUAL

The manual will provide you with explanations of the indicators that we have available on the 
program

HELP ON CURRENT WINDOW

Will provide you with comprehensive information on the window’s features
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The Main Menu
QUOTES

Sub Menu - Chart

Short Cut Access to Trendline
- CTRL T and draw

Drawing Perfectly Horizontal or Vertical Trend Lines
- Hold the SHIFT KEY DOWN and click on the Trend Line Icon
- Click Draw and Click into position, repeat process. When no longer required right 

mouse click

Positioning Trendlines, Text,  Range Tool, Fibonacci & Gann tools exactly at 
High’s and lows

- Click the Tool then hold the ALT down and draw/click

Re Positioning Trend Line
- Click into the middle of the trend line with your mouse pointer on the edge to 

reposition with the same angle

Re Angle the Trend Line
- Click onto the very end of the trend line and  hold your mouse down and move to 

re-angle 

Auto-Extend Trendline
- right mouse click over the trend line and click on Trend Line Properties – Tick 

Auto Extend

Duplicate or Delete Trend line
- Right Mouse click over trend line

Draw Multiple Trend Lines
- Ensure you have ticked this feature under File – Parameters and Chart. This will 

allow you to click – draw – click – draw etc

Ignore the Indicators Properties box
- Hold the shift key and click on the feature.  EG Hold Shift Key down and click on 

Bollinger Bands.  The properties box where you can change the parameters will 
not appear. The Bollinger Bands will be automatically overlayed
This box will NOT appear.  The indicator will be automatically placed on your 
chart
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Change Colour of Chart
- Right Mouse Click
- Click Chart Properties
- Scroll to Colour Settings

Chart Properties Features (right mouse click on chart)

                 

Display Captions
- (Provides a list of all indicators placed on chart in the top left hand corner)

Show non trading
- Choose YES if you wish to view all calendar days
- Choose NO if you only wish to view trading days

Intra Day Period
- Change the intra day period to as low as 1 Minute. You can chose any time period 

you want

Intra Day Cap
- Choose NO if you wish to view as much history as possible
- Choose YES if you wish to limit the period you wish to view
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Intra Day Cap Days
- If you chose YES in Intra Day Cap , you need to choose the period

Daily Cap
- Same as above

Daily Cap Days
- Same as above

Display Data Window
- Will display a small data window that will stay on your chart window

Save Chart – Right Mouse Click
- A saved Chart holds all the content of the chart including indicators, trendlines, 

textboxes and the XCODE the chart is portraying. It is intended as a snapshot of 
that particular XCODE, and saving it allows you to look at it later when more data 
has come in.  This is  especially useful  with trendlines:  it  is  possible to place a 
trendline on a chart, save it as a Chart, and then check regularly whether the price 
has moved in accordance with the expectations implied by the trendline

Save New Template – Right Mouse Click
- The alternative method of saving a created chart is to save as a Template. This will 

save only the content of the chart that is unrelated to price and time, including 
indicators  but  not  including  trendlines  or  textboxes,  and  not  including  the 
XCODE. The Template can then be applied to other XCODEs. You can set up 
your  favourite ways to view stocks,  save it  as  a  Template,  and use it  to page 
through  Watch-lists,  Portfolios or Analyser scan results. 
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Swing Charts

- For those that don’t want the data

Right mouse click and go to Chart Properties. Scroll to the bottom and change the SHOW 
LABELS to a NO instead of a YES

Customise Tool Bar
- Right Mouse click

Here you can add and remove Icons to or from your chart  tool bar. You can also 
reposition them on the tool bar by using the Move Up and Move Down Feature to the 
right.
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Panning Mode
- By holding your middle mouse down you can move re position the chart. Turn the 

panning mode on and off by using the Maltese cross icon

Training Mode
- Allows you to go back to a date in time to evaluate your skills at identify potential 

entries and exits

Zoom Out/Zoom In Price Scale
- Zooms in and out the price scale of the main chart along with zooming out the 

upper or lower price scale

Reset Price Scale
- Use this to reset the chart

Cross Hairs
- Right Mouse - click – hold and move

Toggling through a watch-list
- Most important to right mouse click and click select watch-list

Then utilise these icons to toggle back and forth

.Toggling through an Analyser Scan

- Utilise these icons to view the results from a Scan
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The Main Menu
QUOTES

Sub Menu – Watch-list
When you commenced using Market Analyser you may have pre populated one of our pre 
defined watch-lists.  If you need to return to the Watch-list Wizard you can utilise the Wizard 
Icon

OR

Click on Watch-list on the Top Title Bar and click Watch-list Wizard

Click Next – Choose your Country and then tick the selected Watch-list. 
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Then click update.  This watch-list will then be placed in your main watch-list menu.
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CUSTOMISING THE LOOK OF YOUR WATCH-
LIST
To Customise Columns

- Right mouse click and choose select columns.
Place a tick on or off the selected features you wish to view on your watch-list

Add a comment to a watch-list 
- (You cannot add / delete or edit a watch-list that is generated from an Index’s constituents for  

example ASX TOP 20/50/100 etc.)
Ensure you have ticked “Comment” in the Select Column Feature
Right Mouse Click over the stock you wish to add a comment to and select Edit. 
Add your comment and click Save X Code.

Reposition Columns
- Click and hold and move on the Column Heading 

Place stocks in Alpha Order $ or % Gain/Loss etc
- Click once on the column heading for eg NAME or CODE

Copy Complete Watch-list into another watch-list
- Right mouse click and click COPY
- Open up the second watch-list and right mouse click & Paste

Copy a selection of stocks into another watch-list
- Click hold and drag over your selection. Right mouse click and click COPY
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- Open second watch-list and right mouse click & PASTE
Resize Columns

- Place your mouse between the column dividers until you see a double sided arrow. 
Click hold and drag to size.

Auto sizing 

- For those that have tiled windows you may need to utilise this feature to ensure 
that you can always view the most important information on your watch-list. 

For example you can choose a tiled Watch-list to look like this:

Or like this:
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The second one can be a little hard to follow.

To Auto-Size or Non Auto – Size Watch-list

- Right Mouse Click – Click Appearance Settings – Take the Tick off or place a tick 
in Auto Size Columns

Change the Appearance Settings

- Right Mouse Click – Click Appearance Settings un-tick the Use Default Settings

Copy data into an Excel Spread Sheet

- Right Mouse Click – COPY TABLE
- Open an Excel Spread Sheet and right mouse click – PASTE.
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MOST OF THE ABOVE SHORT CUTS CAN BE 
UTILISED  IN  MANY  FEATURES  OF  THE 
MARKET ANALYSER.

Right mouse click in your favourite window to find 
the additional features available

Alternate Row Colours

- A handy feature for some such as the following:

- Change  the 
Primary  Row 
Colour to Grey

- Change  the 
Secondary  Row 
colour to White

Change the Column Back Ground / Font Colours

- Right Mouse Click and Column Colours. Choose your selection
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The Main Menu
TOOLS

Sub Menu – Instant Message
Send an Instant Message

- Type the @ key and the members operator code or user name in the code box and 
hit enter (You must know the members code or user name MDS does not provide a 
list of these)

EG: @maryjones    or @123456

- Simply type your message and hit send

You can also send a copy, view history messages or choose to ignore an incoming 
message.
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You can  also access  the  menu for  Instant  Messages  under  Menu –  Tools  and 
Instant Message. Simply double click on an operator name and the above window 
will also appear.
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The Main Menu
TOOLS

Sub Menu – Alerts
Send a price alert to your mobile phone

This is a handy feature for those with mobile phone capable of receiving emails. If you are 
unsure you will need to check with your mobile phone provider.

- Open the Alerts window and right mouse click
- Click Add Alert

- Ensure the Enable Alert and Run on Server are ticked
- Set the Alert Condition
- Use the drop down menu to chose “send email”
- Place the email address in the address section
- Click ok.
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Additional Universal Features
Drag and Drop

With almost any window it is possible to drag a XCODE from one window to another by 
holding down the CTRL key on your keyboard and using your mouse.

For example, if both a Chart and Watch-list are open, then, whilst holding your control key, 
click and hold your mouse button on an XCODE or just part of the row. Move your mouse, 
whilst still holding the CTRL key and mouse button to the chart window then release your 
mouse button and CTRL key. (Release the Mouse Button first). The chart will then load from 
that code from your watch-list.

As stated above, this drag and drop functionality will work between almost any window. (You 
can even drag from a chart into a watch-list)

Data Linking

Another way of linking windows together is to use the Data Link option. When most windows 
are open and selected, there will be an additional menu option in the Application Bar, with the 
name of that window. One of the options in that menu is the Data Link option. Selecting the 
Data Link option in various windows will ensure that they all display the same XCODE, no 
matter how it's selected. (i.e. Dragging an XCODE to a data link window will load that same 
XCODE in the other data linked windows. Entering a XCODE into the Code box of the 
Application Bar will load that XCODE into each data linked window. Selecting a row in a 
watch-list, with it's data link enabled, will then load the XCODE from that row into the other 
windows that have their data link options enabled too.) 

For example:

Below is an example of a tiled set up.
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In order to data link you need to click into each window and then use the top title bar and tick 
data link

If you click in a stock in your watch-list it will automatically change the other windows to the 
same XCODE.
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Are you using The Market Analyser Professional with our 
unique Pre Alert Indicators?

Telephone our Membership Department 

1800 096239 

Special packages available to upgrade now.
MDSnews Pre-Alert Trading Technology

The MDSnews Pre-Alert Indicators are based on a unique pattern-recognition concept that has proven to be one 
of the most effective charting and analysis tools available. The Pre-Alert Indicators are designed to help alert 
you to trading opportunities prior to conventional charting indicators and therefore give you a greater chance of 
profiting from market trends.

 
Accumulation Pre-Alert

With the broad underlying trend of global equity markets being bullish, the Accumulation Indicator is designed 
to detect increased buying activity in stocks that are trading at a discounted value. Due to the nature of the 
signal, looking for short-term sell-offs that are then met with unusually high volume, the indicator is most 
successful in periods of market strength and will often identify appropriate entry points at price troughs or 
positive long-term reversal points. Across a 5 year period the Accumulation Indicator has a success range of 
60% to 72% of the time on the ASX top 20 stocks.

                                             

http://www.mdsnews.com/analysistools/default.aspx


 

Distribution Pre-Alert

The Distribution Indicator is essentially looking for periods in a share price where a relatively sharp breakout 
move has occurred with significant volume taking place. With this in mind, the indicator can be applied to both 
rising and falling markets with equally high levels of success. In a down-trending market, peaks which are met 
with high volume can often lead to reversal points and a continuation of the downtrend. In rising markets the 
Distribution Pre-Alert can be used as a breakout alert, as the volume increase identified by the signal is often a 
result of the price action taking out short term resistance levels.

 

Conductor Pre-Alert

The Conductor has been designed as a short-term trend reversal filter. The Indicator can be used on various 
settings to help you pinpoint the ideal entry or exit date in any stock. NOW PROVEN over five years, the 
Conductor Indicator has been independently tested in combination with the MACD and has achieved an average 
return of 20%.

                                             



 

Retracement Pre-Alert

The Retracement Indicator is one of the most powerful indicators available. All experienced traders understand 
that the market moves in cycles and most often when a stock is in a strong up trend it will find renewed buying 
at  50% of  its  prior  move.  It  is  at  these  levels  that  the  smart  money comes back into  the  market.  The 
Retracement Indicator assists you with scanning the market to find these opportunities.

 

Open Channel Pre-Alert

The Open Channel Indicator is designed to alert you to stocks that are trading at the bottom end of their 
trading  range.  Often shares  will  oscillate  between  support  and  resistance.  The Open Channel  Indicator  is 
designed to detect these trading ranges and alert you once the price is showing signs of bouncing off the lower 
level.

                                             



 

Turning Point Pre-Alert

The Turning Point Indicator helps a trader to locate likely reversals within a stock, and is a great visual tool that 
helps remove the guesswork in support and resistance positioning.

A Combination of Pre-Alerts

Pre-Alerts are even more powerful when combined and utilised as part of an overall trading strategy, as each 
Pre-Alert Indicator helps assist in supporting alerts from the others. This method of trading aims to assist you 
in building a much clearer picture when reading the  charts  .   There is no question that the Pre-Alerts are a 
superior way of assisting you to trade the market. If you are relying on industry standard indicators alone, you 
risk leaving your money on the table.
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